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Introduction

Pantone, Inc. is pleased to provide digital support files for download.  These files
will enable you to easily integrate the new and revised PANTONE Libraries into
the most popular design and layout application programs.

This document will describe the files that are provided, the applications for which
they are designed to be used, and provide step-by-step instructions for using the
files within these programs.
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Why are these files necessary?

The PANTONE Solid To Process product has undergone significant changes
from earlier editions. These changes are outlined in the copy pages of the Guide,
and are reproduced below as follows:

*New brighter paper stock
*Line screen ruling changed from 150 to 175 line
*Print sequence changed from CMYK to KCMY
*Colors produced with full digital CTP workflow
*Addition of 147 new designer-inspired colors

As a consequence of these changes, the CMYK values used to simulate the
existing PANTONE Colors have changed from earlier versions.  The support files
that are posted on the Pantone Web site will allow users to import colors with the
revised CMYK simulation values, to be consistent with the updated publications.
Of course, CMYK simulations for 147 new PANTONE Colors are included as
well.
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File Listing

The following list describes each download that is available and for what the files
can be used.  The next section will provide step-by-step instructions for importing
the supplied files to documents within popular application programs.

File Name Description
Single EPS with all 1,089 colors Contains no artwork.  Useful for

importing the revised solid to process
library into popular design programs.

Individual EPS Files Full solid to process library broken up
into ten separate EPS files. File names
correspond to the page numbers in the
PANTONE solid to process guide and
PANTONE solid to process chips.
Contains printable color chart with
colors identified by name.  Useful for
users to import only certain colors or to
print out a color chart to test the output
of PANTONE Colors on a particular
device.

Individual TIFF Files Full solid to process library broken up
into ten separate TIFF files.  Useful for
importing PANTONE Colors into
applications that do not currently offer
PANTONE Color Support, but do
support TIFF file format.

PDF Color Chart Printable PDF chart for those using a
PDF workflow.  Can be output to test
PANTONE Color reproduction on a
particular device.

PDF Value List Text document listing all 1,089
PANTONE Colors, together with 
CMYK data. 
Useful for “building” color swatches
inside applications that do not offer
PANTONE Color Support but do
support CMYK color space.

Raw PostScript Color Chart Can be brought directly to a RIP to test
output of PANTONE Colors on a
particular device.

PANTONE ColorDrive file Full solid to process library as a
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PANTONE ColorDrive file, allowing
users of PANTONE ColorDrive to
import the revised solid to process
library.

PANTONE ColorReady file
(Macintosh® only)

PANTONE ColorDrive file which can be
used within PANTONE ColorReady to
import the revised solid to process
colors.

Using Supplied EPS Files to Access New PANTONE Colors

This section will provide step-by-step instructions for using the downloadable
EPS files to access colors from the new PANTONE solid to process guide from
within various applications.

The downloadable PANTONE Libraries have a different naming convention than
the older libraries available within Illustrator, FreeHand or QuarkXPress. If
these colors are imported to documents where the same PANTONE Colors
exist, the elements will not automatically redefine with the new versions of
the colors, leaving you with two versions of the same color. Therefore, the
previous version of the color will have to be removed and replaced with the
new version of the color. Each application section describes how to
work around this.

Adobe Illustrator 7.0 and later

Importing Colors to Documents from EPS Files:

1.  Open a new or existing document. (If you are using Illustrator 9, you
     MUST choose CMYK mode rather than RGB mode when prompted.)
2.  From the “Window“ menu, choose “Swatch Libraries,” then “Other
     Library.”
3.  Navigate to the desired EPS file.
4.  Illustrator opens a separate window with your palette.

Adding Imported Colors to Your Document Palette:

1.   Click on each color in the imported palette.
2.   The new Spot Colors are added to your Document Palette.

To Use a Larger Sample of the Palette:

1.  Click the first color in your palette.
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2.  Depress the shift key and click the last desired color, so all swatches
     within a range are selected.
3.  Click the “Fly Out Triangle“ at the upper right of the palette window,
     and select “Add to Swatches.”
4.  All selected colors are added to the Document Palette.

Workaround for the Color Name Change:

1.  Locate the colors that you want to replace in the Illustrator “Swatch
     Palette.”
2.  Select the first color, then press the "Shift" key and select the last
     color, so the entire group is selected.
3.  From the fly out menu on the Swatches palette, choose “Delete.”
4.  Illustrator will confirm your instruction. Click “OK.”
5.  Choose the “Pointer” from the toolbar.
6.  Click the first object to be colored and then click the desired color
     from the imported colors in the Swatches palette. The object is
     defined with the selected color.
7.  Repeat this process for all objects to be colored.

Adobe Photoshop 4.0 and later

The individual EPS Files can be used to paint objects with the PANTONE Colors.
To Use the EPS Files in Photoshop:
1.   Open the appropriate file from your hard drive.
2.   Use the “View“ command to zoom in, if necessary, to make the
      PANTONE Color Names readable.
3.   Open the document where you wish to use the colors.
4.  Use the “Window“ menu to toggle back to the EPS document.
5.   With the “Eyedropper Tool,” select the desired color. The foreground
      color square reverts to the selected color.
6.   Switch to the other document and use the “Paint Bucket“ to apply
      the color to the desired object.
7.   Repeat steps 4 through 6 until all objects are colored.

Adobe InDesign

The process of importing colors from EPS Files within Adobe InDesign
is identical to that used in Adobe Illustrator. The procedure is reproduced
as follows:
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Importing Colors to Documents from EPS Files:

1.  Open a new or existing document.
2.   From the “Window“ menu, choose “Swatch Libraries,” then “Other
      Library.”
3.   Navigate to the appropriate file on your hard drive.
4.   InDesign opens a separate window with your palette.

Adding Imported Colors to Your Document Palette:

1.  Click on each color in the imported palette.
2.  The new colors are added to your Document Palette.

To Use a Larger Sample of the Palette:

1.  Click the first color in your palette.
2.  Depress the shift key and click the last desired color, so all swatches
     within a range are selected.
3.  Click the “Fly Out Triangle“ at the upper right of the palette window
     and select “Add to Swatches.”
4.  All selected colors are added to the Document Palette.

QuarkXPress 3.32 and later

Importing colors from an EPS to your Document Palette:

1.  Draw a picture box on the document.
2.  From the File menu, choose Get Picture.
3.  Open the desired EPS file.   The single EPS file will import all 1,089

PANTONE Colors with their CMYK simulations. The individual EPS files,
keyed to the page numbers in the PANTONE solid to process publications,
will import the colors that appear in the selected page range.  The colors will
be added to the document Color List.

4.  Delete the picture box. The colors remain in the Color List and are
     available for use.

Workaround for the Color Name Change:

1.  From the “Edit” menu, choose “Colors.” The “Edit Color” dialog
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     box opens.
2.  Locate the duplicate PANTONE Color.
3.  Select the old version of the color you wish to replace and click
      "Delete.”
4.  QuarkXPress will prompt you to replace the color with another
     color.
5.  Select the newly imported version of the color and click “OK.” The
     element is defined with the new color.
6.  Repeat this process for each color in the color list.

Macromedia Freehand 7.0 and later

Using colors from EPS Files in a new or existing FreeHand document:

 1.  Using the File/Open command, open the desired downloaded EPS file.
 2.  Click the “Options“ button on the “Color List“ palette and click
      “Export.”
 3.  Choose the colors you wish to export and click “OK.”
 4.  Type a name in the “Library” box.
 5.  Type a filename, leaving the .bcf extension, and click “Save.” The
      file will be saved to the color folder within Freehand. If you do not
      choose a file name, the file will be saved as Custom.bcf. If you
      wish to change the location of the file, click "Save As" (Macintosh)
      or "Browse" (Windows), choose a location, then click "Save.”
 6.  Open a new or existing document.
 7.  Click the “Options” button on the “Color List” palette and click
      “Import.”
 8.  Navigate to your new library and click “Open.” The “Import” dialog
      opens.
 9.  Click the first color, then hold the shift key and click each additional
      color until all desired colors are selected.
10. Click “OK.” The selected colors will be added to the document
      “Color List.”

Workaround for the Color Name Change:

Preferred procedure

 1.  Activate the “Color List” from the “Window/Panels” command.
 2.  Locate the duplicate PANTONE Color.
 3.  Select the version you want to delete.
 4.  Click the Options drop-down and choose "Replace.”
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 5.  FreeHand will prompt you to replace the color. Select "Color List."
 6.  Scroll to the newly imported version of the color and click “OK.”
      The element is defined with the new color.
 7.  Repeat this process for each color in the color list.

Alternate procedure

 1.  Activate the “Color List” from the “Window/Panels” command.
 2.  Locate the list of PANTONE Colors that you want to replace.
 3.  Select the first color, press the "Shift" key and select the last color
      so the entire group is selected.
 4.  From the "Options" drop-down list, choose “Remove.”
 5.  FreeHand will prompt you that removed colors will be defined as
      process colors. Click “OK.”
 6.  Locate the new versions of the PANTONE Colors.
 7.  Drag each color to the element you wish to color.
 8.  The elements are redefined with the new colors.

Using Supplied TIFF Files to Access New PANTONE
Colors

TIFF (Tagged Image File Format) Charts are another format we provided to
allow you to access the new guide colors, as they are not yet directly supported
by applications.

Adobe Illustrator 7.0 and 8.0

Adobe Illustrator can be used to create new Spot Color Swatches
using the TIFF Chart. Follow these steps:
 1.  Open the TIFF Chart in Illustrator.
 2.  Using the “Eyedropper,” sample the desired color. The CMYK
      values display in the “Color“ window.
 3.  On the “Swatches Palette,” click “New Swatch.” A new swatch is
      created with the color.
 4.  Double-click the swatch. The “Swatch Options“ window opens.
 5.  Type a name for the color, if desired, and change the “Color Type“
      to Spot Color.
 6.  Click “OK.” The swatch appears in the “Swatches Palette“ with
      your name, defined as a Spot Color.
 7.  Repeat steps 2 through 6 for each color in the TIFF Chart that you
      wish to use.
 8.  From the “File“ menu, choose “Save,” then save as either Illustrator
      or Illustrator EPS, as desired.
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PANTONE ColorDrive

PANTONE ColorDrive can be used to read TIFF Charts and convert
them to PICT, GIF or JPEG files. Use the following steps:
 1.  Open the TIFF chart in ColorDrive.
 2.  From the “File“ menu, choose “Save As“ (version 1.5) or “Export“
      (version 1.5.3+).
 3.  If you wish to embed a profile in the image, uncheck ““Match
      Image,” then use the “Profile“ button to embed the desired profile.
 4.  Choose a location for the file, and click “Save“ or “Export.” The file
      is saved in the desired type.

Using revised solid to process library in PANTONE
ColorDrive and PANTONE ColorReady

PANTONE ColorDrive software can be updated by dragging the provided
PANTONE ColorDrive file to the Library folder inside the PANTONE ColorDrive
folder on your computer’s hard drive.  For Macintosh, the revised solid to process
library will be accessible from the Library menu.  For Windows, you can access
the revised library using the File/Open command.

PANTONE ColorReady can be updated by dragging the PANTONE ColorDrive
file to the System Folder/Preferences/Pantone/Library folder.  The revised solid
to process library will be accessible from the PANTONE Library drop-down menu
on the PCR Setup window.  PANTONE ColorReady should not be running when
the library is added.  If it is, you will need to close the host application and restart
it for the new solid to process library to be visible.


